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COPYRIGHT NOTICE

The contents of this Manual, the tracking algorithms and position control used in TS3010 are the
property of TUNRA Ltd and The University of Newcastle, NSW Australia. All software

contained within the TS3010 system is subject to copyright.
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3.         GENERAL INFORMATION

3.1. How to Use this Manual

3.1.1. This manual is divided into sections to provide easy access according to the user's needs.

3.1.2. The specification of TS3010 and a general description of the system are provided within
this section.

3.1.3. Section 4 introduces the subject of geostationary satellites and methods used to follow
their motion.

3.1.4. Section 5 provides a detailed description of TS3010, indicating the roles played by its
various components.

3.1.5. Section 6 describes the concepts of control and data presentation in the TS3010, and how
to go about specific tasks.

3.1.6. Section 7 describes facilities included in TS3010 for the calibration of antennae - a task
which will be required for new installations, or possibly after any major structural changes to an
antenna.

3.1.7. Sections 8 and 9 provide reference information for installation, maintenance and repair of
the TS3010 system.

3.1.8. A Manual Supplement provides information relevant to a specific antenna. There is one
Manual Supplement issued for each antenna installation.

3.1.9. Appendices and Annexes to this and a Manual Supplement contain detailed reference
data which may be useful from time to time during normal operation or repair.

3.2. General Description of TS3010

3.2.1. TS3010 is a control system containing algorithms to track slowly moving satellites. It is
designed to control large satellite-tracking antennae. These will generally have beamwidths of
less than 0.3 degrees, and be operated under continuous automatic position control.

3.2.2. The basic TS3010 system consists of:-

a. The Antenna Tracking and Control Unit, or ATCU. This computer performs the
computations necessary to establish the antenna pointing angle to the satellite, and to
issue rate demands to the antenna drive system in order to hold the antenna at the correct
position.

b. The Control and Monitoring Unit, or CMU. This computer provides a user-friendly
interface from which the operator may control the ATCU. It communicates with the
ATCU through a serial data link.
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3.2.3. Contained within the basic TS3010 are all the facilities necessary to interface with
the antenna drive system and the antenna position monitoring system. Both of these can
be tailored for a particular installation. For instance, electric and hydraulic drives can be
accommodated, and position monitoring systems such as angle encoders, resolvers,
synchro. systems or displacement transducers can be catered for. Also included is a
capacity for interfacing with antenna system interlocks and alarms.

Fig. 1  TS3010 Basic System Block Diagram

3.2.4. Optional extensions to the basic TS3010 include:-

a. An additional CMU. This enables control of the system at one of two alternative
positions. Particularly useful for drive, position monitoring system and ATCU tests when
the main control is normally in a separate building at a Remote CMU (the RCMU), a
Local CMU (the LCMU) - may be located adjacent to the ATCU. Control of the ATCU
may then be passed between the LCMU and the RCMU.

b. Terminal Panel. This provides connection facilities to external circuits and supports
ancillary services, such as a resolver Reference Supply.

c. Polariser Control Unit.

3.2.5. The entire TS3010 is based upon standard components. The computers used are based on
the 80386+80387, 80486 or Pentium processor and have an Industry Standard Bus (ISA bus). No
special-to-type components are used. The ATCU is an industrial-grade, rack-mounted computer.
For a CMU, any Pentium-based computer may be used, provided it has the resources required to
run MS-Windows NT.

Antenna Drive control
Antenna Position data

Interlock circuits

Signal strength
from Beacon
Receiver

Antenna Tracking and
Control Unit   (ATCU)

Control and Monitoring
Unit   (CMU)

CMU/ATCU serial
communications



TS3010 Satellite Tracking System MANUAL
_____________________________________________________________________________

Page 11 of 60

©TUNRA Ltd 1998                                       DOC- 000 017 7                                        $Revision::   1.11  $

3.3. System Specification

3.3.1. Performance

NOTE: Performance of a tracking system is very dependent upon factors other than the
tracking control system itself. The following data is provided as a guide only, as being
typical of TS3010 when operating on a typical antenna in good condition.

• Antenna Position Control Error: Less than 0.002 degrees static, 0.02 degrees dynamic.

• Tracking error using ORBIT TRACK in active tracking: Less than 5% of beamwidth.

• Maximum antenna slew rate demand: 1.0 degrees/second.

• Maximum antenna acceleration demand: 1.0 degrees/second/second.

• Full, integrated antenna Drive system control and condition monitoring.

• Motion control methods available:-
• Position demand - azimuth and elevation axes;
• Rate demand - azimuth and elevation axes;
• ORBIT TRACK beacon and model tracking;
• Intelsat  model tracking;
• NORAD (NASA) model tracking;
• Scanning (searching) for a satellite;
• Star model tracking with Antenna Calibration Sequence (ACAS) motion, and
• External control (of position demand) via serial data link.

• ORBIT TRACK satellite model storage capacity: 10 models.

• INTELSAT satellite ephemeral data storage capacity: 10 models.

• NORAD satellite ephemeral data storage capacity: 10 models.

• Beacon system interface capacity: Can monitor up to two signals simultaneously, with
tracking based on one (selected) signal. Beacon system setups for up to 10 satellites
may be stored.

• Star data storage capacity: 5 stars.

• Trending data display of azimuth and elevation values and beacon signal strength, in
real time and historical mode.  Historical data availability is preset to 30 days
maximum of continuous operation. Trending data printout capability is in-built.

• Polariser filter position control error: Less than 0.1 degrees.

• Stowing to preset positions on both axes, and control of two stowpins is provided for.
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• Event text file records permanently stored, and available for review and printing.

3.3.2. Interfaces

3.3.2.1. Digital I/O

3.3.2.1.1. The actual number and configuration of digital inputs and outputs for the TS3010
is dependent upon the particular installation’s requirements. Generally, each input or output will
conform to the following specification:-

a. Digital Outputs:
Nominal load: 3amps @ 120 VAC or 24 VDC.
Max. switching power: 96 VA, 120 W.
Max. switching voltage: 250 VAC, 150 VDC.
Max. switching current: 3 amp.
Max. continuous current: 3 amp.
Max. contact resistance: 70 mOhm.
Insulation resistance: min. 250 MOhm at 500 VDC.
Dielectric strength: 750 VAC 1 minute between open contacts, 2000 VAC 1

minute between contacts and computer ground.
Surge strength: 6000V at 1.2*50 microsec. standard surge wave.

b. Digital Inputs:
Minimum load: 800 ohms (nominal)
ON input voltage: 5-24V DC to 1000 Hz
Isolation: 1000 VDC, 5000 Mohm.

3.3.2.2. Beacon Receiving System Interface

3.3.2.2.1. In general, a digital serial communications link is used for communication
between the ATCU and Beacon Receiver system units. Consult the Manual Supplement for
details relating to a particular installation.

3.3.2.3. External Control Interface
One standard RS-422 serial communications interface with the ATCU.

Baud rate: 9600
Data bits: 8
Stop bits: 1
Parity: None
Control Protocol: None

Connection: One 9 pin D male connector on the ATCU. The standard port used is COM4.
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The required format of the ASCII-coded message is:-

ENQAaaaa.aaa eeee.eee chksmETX

where:-
ENQ and ETX are the ASCII control characters;
A is the address byte for the ATCU - upper case ASCII `A';
aaaa.aaa and eeee.eee are the required azimuth and elevation angles respectively,
in degrees;
chksm is a check sum byte, calculated over all characters after STX and before
chksm as follows:-

chksm = ((SUM AND 63) XOR (SUM IDIV 64)) + 32
where SUM = (∑ bytes)modulo 256

AND, XOR are the bit-wise logical operators;
IDIV is the integer divide operator.

3.4. ATCU-CMU Communication

3.4.1. The ATCU is normally fitted with two serial ports for communication with CMUs. These
are COM1 and COM2, unless otherwise indicated in the Manual Supplement covering the
particular installation. When connected to COM1, a CMU becomes known as the ‘Local’ CMU
(LCMU). Connection to COM2 causes a CMU to become the ‘Remote’ CMU (RCMU). There is
no other functional difference between the two ports.

3.4.2. Communication is in standard ASCII character strings, with the following parameters:-
Baud rate: 9600
Data bits: 8
Stop bits: 1
Parity: None
Control Protocol: None

Connection: Two 9 pin D male connectors on the ATCU.

3.4.1. Power and Cooling
Primary power: 240 V or 110 V AC, +/- 10%, single phase 50 or 60 Hz.
Power consumption: 250 watts maximum for ATCU and CMUs, each.
No forced cooling is required.

 3.4.2. Operating Environment

Ambient temperature:  0 to 50 degrees Celsius.
Humidity: 8 to 80 % RH.
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3.4.3. Dimensions

Measurements are in mm and Kg, and are nominal. Any particular installation may use
equipment which varies from these guidance values.

UNIT HEIGHT WIDTH DEPTH
ATCU 178 483 472
CMU computer 178 483 472
CMU display 355 483 453
CMU keyboard 45 483 472
Polariser Control Unit 262 483 275
Manual Control Unit 610 82 70

3.4.4. Safety

**** WARNING ****

TS3010 EQUIPMENT CONTAINS EXPOSED DANGEROUS
ELECTRICAL POTENTIAL

Contact with AC electrical potentials in excess of 100 volts can be
made if the back of the TS3010 rack is removed, or if the hinged
cover on the front of the Polariser Control Box at the front of the

TS3010 rack is open.

Hazardous AC and DC potentials can be contacted if the case of a
CMU display unit is removed.
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4.         INTRODUCTION TO SATELLITE TRACKING

4.1. Communication Satellites and their Motion

4.1.1. Communications satellites may be either geo-stationary or in low orbit. TS3010 is
specifically designed to track the relatively small movements of the geo-stationary type. These
satellites, nominally stationary with respect to the Earth's surface, move in a cyclic fashion about
a position which may itself drift slightly with time. The motion is brought about by gravitational
effects of the Sun, Moon and Earth on the satellite.

4.1.2. To be perfectly stationary above the Earth's surface, a satellite must move in the Earth's
equatorial plane. However, the effect of the Sun is to move it towards an orbit in the solar plane,
causing the satellite to increasingly move cyclically north and south with respect to the Earth's
surface. These satellites are provided with propulsion to correct this tendency, but in order to
extend the life of the satellite the propulsion system is used as little as possible, allowing quite
large motions to build up. Additional effects from sun and moon eventually cause minor east-
west cyclic motions and drift.

4.2. Satellite Tracking Methods

4.2.1. There are two basic methods of controlling an antenna so that it maintains its signal path
beam axis pointing at a satellite. These are the active and passive approaches.

4.2.2. In active tracking, a signal from the satellite is used to provide information to control the
antenna. In the TS3010, the ORBIT TRACK system causes the antenna to occasionally move
slightly in steps, about first one axis then the other. This causes a very slight drop in the strength
of a beacon signal (transmitted by the satellite) and received in the antenna. The way in which
this strength varies as the antenna moves, is detected and used to calculate where the antenna
should point, in order to maintain the signal at maximum strength. ORBIT TRACK, whilst
actively tracking the satellite, builds a model of the satellite's motion. This model is followed, as
in ‘passive tracking’, between the stepping motion operations, and if the beacon signal strength
data fails for any reason.

4.2.3. Passive tracking is accomplished by driving the antenna to follow a model of the
satellite's motion. Two alternative model-following systems, based on INTELSAT and NORAD
(NASA) model data, are also provided in TS3010.

4.2.4. The INTELSAT and NASA organisations provide satellite motion model data for various
satellites, in standard forms of parameters for defined polynomial model functions. These models
produce latitude and longitude vs. time information for a satellite, and these must then be used to
determine pointing angles for the antenna, based upon a knowledge of its location on the surface
of the Earth. The parameters must be updated on a regular basis to maintain pointing accuracy.

4.2.5. As the passive tracking method is essentially an `open-loop' operation, the pointing
accuracy maintained is highly dependent upon the rigidity of the antenna and the absolute
accuracy of the position monitoring system. Active tracking, on the other hand, almost
completely eliminates these sources of error. ORBIT TRACK, with its model built from active
tracking information, provides the advantages of active tracking whilst not requiring continual
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movement of the antenna.
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5.         SYSTEM DESCRIPTION

 5.1. The ATCU

5.1.1. The ATCU is a rack-mounted industrial computer. It normally operates without screen or
keyboard, and is controlled through serial data links by either the LCMU or the RCMU. It has no
hard disk - its program is stored in a solid-state disk emulator as firmware, and it is fitted with
non-volatile memory, for the storage of system parameters.

5.1.2. All tracking and control loop calculations are performed by the ATCU. It interfaces with
the antenna, the drive system, the antenna position monitoring system and the beacon receiver
system.

5.1.3. The ATCU has two parameters which indicate its current operation. These are titled
MODE and STATE, and are displayed continuously by the CMU.

5.1.4. The MODES of the ATCU are:-

a. POSITION. Used for positioning the antenna to point in a nominated direction.

b. RATE. Used to move the antenna at a nominated angular rate about each axis.

c. ORBIT TRACK. The mode in which all Orbit Track operations are performed.

d. INTELSAT. In this mode, the ATCU will perform Intelsat model tracking.

e. NORADTRACK. Similar to INTELSAT Mode, but the NORAD model is used.

e. STAR TRACK. This mode is used for antenna calibration, providing the capability of
following star motions.

f. SCANNING. Used when searching for a satellite, this Mode allows for motion in either
a bar or spiral scan pattern.

g. EXTERNAL. In this mode, the TS3010 will control the antenna according to position
information received via a serial data link to the ATCU Control Port. Drive ON/OFF
control remains with the CMU in control, and no antenna motion will occur until a valid
message is received at the ATCU’s Control Port.

h. DIAGNOSTIC. This mode is used only for fault-finding and hardware testing within
the ATCU. It is not selectable from a CMU.

5.1.5. Within each MODE, the ATCU operates in a number of STATES. Some or all may be
appropriate to a particular MODE. The main STATES of the ATCU are:-

a. OFF. The Drive system is not enabled.

b. MANUAL. The ATCU cannot control the Drives because the Computer Control
Inhibit input to the ATCU is ON.
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c. STANDBY. The Drives are powered and under ATCU control, but not operating.

d. STARTING. The Drives are starting. Depending upon the Drive configuration, this
may last for a significant period, or be passed through almost instantaneously. This State
is intermediate between STANDBY and HOLDING.

e. HOLDING. Under ATCU control, the Drives are operating, and the antenna is being
held at a steady position.

f. SETTLING.  Under ATCU control, the Drives are operating, and ATCU is waiting for
the antenna to settle on a steady position. This is a transition state which occurs just
before entering the HOLDING state.

g. SLEWING. The ATCU is causing the antenna to slew rapidly to a new position, or in
RATE Mode, at a given rate.

h. FOLLOWING. The antenna position is being controlled to closely follow position
demands generated within the ATCU. This state is seen in POSITION and SCANNING
modes, and at the start of a Tracking operation.

j. STEPPING.  This state is entered when the antenna is being driven in the ORBIT
TRACK Mode, in a stepping motion to check on satellite position.

k. MODEL TRACK.  A satellite model is being followed between stepping actions in
ORBIT TRACK, or whilst following a model in Intelsat, Norad or Star Track mode.

5.2. The CMU

5.2.1. The CMU is really a software application run on a general purpose computer. The
application runs under the Windows NT Operating System. Program, alarm log. and Trending
files are held on a normal hard disk. A floppy disk drive and CD-ROM drive is required for
setting-to-work and maintenance purposes.

5.2.2. Although two CMUs can be connected to one ATCU, only one CMU can be in control of
the ATCU at any one time. The other CMU is then purely a monitor. Control can be taken away
from the CMU in control ONLY IF THAT CMU RELEASES CONTROL. If control is released
whilst the ATCU is carrying out an antenna move or is tracking, the ATCU will continue in its
current task for a time which may be set from a CMU whilst it is in control. At the end of that
time, if control has not been taken by one of the CMUs, the ATCU will drop to the STANDBY
State, stopping all antenna movement.

5.2.3. The CMUs provide the operator-interface with TS3010. The only system data held in a
CMU when it is turned off is its own serial port assignments and Trending chart display settings.
All other system data is held by the ATCU, the CMU obtaining it from the ATCU as required.

5.3. The Operator Interface

5.3.1. The operator interfaces with the TS3010 computer system via the display, keyboard and
mouse of a CMU computer. The CMU program supports a standard Windows-NT Graphical
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User Interface (GUI), providing information and control facilities covering all aspects of TS3010
operations (other than some installation-specific setting of constants, which is adjusted through
the ATCU directly).

5.3.2. When the CMU program starts, the whole screen is filled with the display depicted in
Fig. 2:-

Fig. 2  CMU Display on Startup

5.3.3. The CMU always displays, in a ‘Condition Panel’ (positioned just below the Menu Bar),
summary information about the tracking system and antenna status. The data provided in this
panel is:-

a. TS3010 system time, date and the reference source for time and date;
b. antenna identity;
c. point of control of the antenna Drive system;
d. antenna azimuth and elevation pointing angles (and azimuth cable wrap condition, if
applicable to the antenna);
e. beacon signal strength;
f. selected satellite or star identity, and
g. ATCU Mode and State.

All this information is obtained from the connected ATCU. If the CMU is not communicating
with an ATCU, no information is displayed.
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The panel contains one control - a button - which provides the means of taking and releasing
control of the ATCU.

5.3.4. Across the bottom of the display is a ‘Control Panel’, which contains control buttons to:-
a. ‘Go Back’ - revert to a previously displayed view;
b. start and stop the Drives;
c. start and stop antenna motion, and
d. gain access to antenna Stowing operations.

5.3.5. The space between the Condition Panel and Control Panel is filled by a panel which may
be selected from the Views menu in the Menu Bar. At startup, the Positioning and Tracking panel
is displayed here, as shown in Fig. 2.

5.3.6. Standard MS Windows style Help is available from the Help menu, both by searching a
Help file, and by the presentation of context-sensitive information. 
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6.         OPERATION

6.1. System Start-up

6.1.1. Each component of TS3010 may be turned on independently of the others. There is no
required sequence to this.

6.1.2. The TS3010 ATCU will start up with the ATCU in POSITION MODE, and if not under
Manual control, control of the ATCU will be available at any connected CMU.

6.1.3. CMUs will initialise by starting Windows NT. When this action is complete, one instance
of the CMU program will start automatically. If an ATCU is connected to the CMU computer’s
serial port set for the first instance of the CMU program, the program will automatically
configure itself for that ATCU and antenna. If not, none of the TS3010 system data or controls
will be active or reflect any data. Nor will Trending data or Event log files be opened, and access
to Beacon, Polariser, satellite and star data, and system status will not be possible.

6.1.4. The operator may start additional instances of the CMU program, by clicking on the
TS3010 CMU icon provided on the Windows desktop. Multiple instances of the CMU program
may be run concurrently, however no two can be connected to the same serial port. The program
detects existing instances of itself, and initially configures the serial port for ATCU connection
accordingly - COM 1 for Instance 1, COM 2 for instance 2, and COM 3 for Instance 3. No more
than three instances are allowed. An attempt to start a fourth will fail. Once started, the port
assignment for the active instance may be changed via the Configuration dialog box (available
through the System menu). Thereafter any instance of the same instance number will be assigned
that port. The program will not allow connection of more than one instance to any one port.

6.1.5. The main window of the CMU program may be sized, however the contents do not
change in size. Thus a reduced main window results in a clipped display. (This can be used to
facilitate the allowed maximum of three instances running on one computer, with just the
Condition Panel of each showing - that panel being full screen width and about one-third screen
height.)

6.1.6. Any dialog box generated by an instance of the CMU program bears the name of the
antenna connected to that instance, in its title bar. Note that these dialog boxes are NOT clipped
by a reduced main window, and can exist outside that window.

6.1.7. All Trending and Event log. files are stored in a default-drive directory having the name
of the antenna connected. Thus with multiple instances running and connected to different
antennae, these files are maintained independently for each antenna.
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6.2. System Shut-down

6.2.1. The TS3010 ATCU computer program is normally terminated by turning the ATCU
computer off. THIS ACTION SHOULD NOT BE TAKEN IF THE ATCU IS MOVING THE
ANTENNA, AS THIS MAY JAR THE ANTENNA STRUCTURE. At any other time, the
ATCU may be turned off.

6.2.2. A CMU may be shut down at any time, however if the CMU in control is shut down
whilst the antenna is being moved by the ATCU, that motion will be terminated after a preset
time. A CMU computer should ONLY be shut down by terminating all CMU instances AND
Windows NT BEFORE turning power off. The CMU program may be terminated by:-

a. activating the Close control on the program’s main window Title Bar ( a small cross in
the top right-hand corner), or
b. selecting Exit from the System menu.

6.2.3. When closing down a CMU computer ALWAYS close Windows NT properly. Do NOT
just turn power off, as this can result in a less than satisfactory startup next time the CMU is
activated.

6.3. CMU Operations

6.3.1. Visual Cues and Operator Actions

6.3.1.1. Throughout the TS3010 CMU Operator Interface, consistent colouring,
appearance and method of operation are maintained. The standard MS Windows appearances are
retained throughout, with colored buttons being used for mission-sensitive controls. Briefly, this
means that:-

a. If a control is ever available in a particular installation, it is always shown. However, if
its action is not appropriate to the current conditions, it is disabled, and its appearance
‘greyed-out’. For buttons, this condition is indicated by the button’s label appearing
greyed and depressed. For edit controls, the background (normally white) is set to the
general background colour of the window in which the edit control appears.

b. If activating a button control could mean disruption of signal traffic, it is colored red.
For such buttons with alternative functions (for instance, the button which starts the
Drives if they are stopped, and stops them if they are running) the alternative colour is
green. The labelling on all buttons indicates the action which may result if the button is
activated. Thus, for instance, the Drives control button’s label is ‘Start Drives’ if the
Drives are stopped, and ‘Stop Drives’ if the Drives are activated.

6.3.1.2. Operator actions are performed through a combination of mouse and keyboard
actions. The method follows the standard MS Windows arrangement, although ‘hot-key’ action is
provided for Menu and Menu Item selection, and Help access.

6.3.1.3. Changes to system data are generally sent to the ATCU when the data-entering
operation is completed (by pressing the Enter key) . Exceptions to this are some data groups
accessed through dialog boxes. In such cases, no data is sent to the ATCU until the Set button
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provided in the dialog box is activated. If a change is made within such a data group, and action
taken to kill the dialog box without activating the provided Set button, the user will be prompted
to confirm the loss of changes or have them accepted.

6.3.1.4. If the operator takes any action which could cause disruption to signal traffic (such
as stopping the Drives whilst tracking is in progress) a warning dialog box appears, requesting
confirmation of the action. (This includes closing down the CMU application if it is in control of
a tracking ATCU, as the ATCU will eventually stop tracking if it is not under CMU control.)

Fig. 3  Traffic Disruption Warning

Note that this warning does not occur if the ATCU is not currently in a tracking mode, and is not
in a ‘tracking’ state ie Model Track or Stepping.

6.3.2. Moving Around in the CMU Interface

6.3.2.1. Access to TS3010 system setup facilities, CMU views and Help is available via
the Menu bar at the top of the CMU display. Three menus are provided. From the left, they are:-

a. System;
b. Views, and
c. Help.

6.3.2.1. The System Menu

6.3.2.1.1. By clicking on the System heading in the normal Windows manner (or pressing the hot
key combination Alt-S), the System menu is displayed, as in Fig. 4:-

Fig. 4  The System Menu
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6.3.2.1.2. Extending the System menu allows four selections:-

(i) Configuration
Selecting Configuration generates a dialog box which allows for setting the serial ports
used by this instance of the CMU Application:-

Fig. 5  The System Configuration Dialog Box

No change can be made to a serial port connection until the connection to be changed is
broken, by activating the appropriate Disconnect button. Then, the Port selector becomes
active, and if its ‘drop-down’ button is activated, it will show a list of Com ports 1, 2, 3
and 4, from which a selection may be made. (The list will show all of these, even though
some may not exist, or may be in use.) If a port is selected which is unavailable (either
because it is already in use or it does not exist) and connection is attempted, a message
appears suggesting that another selection be made.

This dialog box also allows the user to set the ATCU’s Control Point Timeout Limit. This
sets the time for which the ATCU will continue to follow its current action after control of
it has been released. If control is taken up by a CMU within the set time, the ATCU will
continue its normal operation. If not, it will revert to its Standby state, with all motion
stopped.

The Configuration dialog box is dismissed by clicking the Close button at the right-hand
end of its Title Bar.

(ii) Set System Time

This selection opens the dialog box shown in Fig. 6, allowing the user to set the ATCU
system time and date.
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Fig. 6  The System Time and Date Dialog Box

Note that any changes made to the settings in this box do not become effective until the
Set button is activated. Any settings made here have NO EFFECT on the CMU
computer’s clock. They only affect the ATCU’s clock, which is the clock supplying the
time and date displayed by the CMU Application.

Note also that if the ATCU’s clock is locked to an external source, this dialog box will be
unavailable.

(iii) Reset ATCU

Selecting Reset ATCU has no direct effect  on the CMU. It forces a ‘Soft Reset’ of the
ATCU computer, which will then automatically restart its operating system and the
ATCU program. Thus a few seconds after making this selection, the CMU’s display will
replace all the data normally being collected from the ATCU by blank spaces or default
text, until the ATCU restarts and again communicates with the CMU.

(iv) Exit

The Exit selection from the System menu closes down this instance of the CMU program,
leaving the Windows NT system running.

6.3.2.2. The View Menu

Fig. 7  The View Menu
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6.3.2.2.1. Extending the View menu provides the means of changing the panel displayed in
the centre of the screen, displaying the Events dialog box and activating the general purpose text
editor SuperEditor. Details of the selections available are:-

 (i) Alarms and Events

This selection activates a dialog box in which is displayed all active system alarms, and
listed events.

Items listed in this dialog box are shown in chronological order, from top to bottom. If the
list is too long to be shown, a vertical scroll bar control appears on the right-hand side,
allowing the user to scroll the display up or down through the list.

Events having Event Number 000 are general system change notifications. They include
all changes of ATCU mode and state, changes of the antenna being monitored, and ATCU
control point changes.

Events other than those numbered 000 are alarms. Alarms listed are all alarms currently
active in the system.  These are classified as Major - the Drives are turned off if one of
these occurs - and Minor. If an alarm condition is cleared, the alarm is automatically
removed from the list. Each alarm has a unique number, from 001 to 999 inclusive. A list
of possible alarms is provided in the Manual Supplement for each installation.

Fig. 8  Events and Alarms Dialog Box
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Activating the ‘Clear List’ button removes all events numbered 000 from the display,
leaving only currently active alarms.

The displayed list is updated continuously, so that any event occurring whilst the Events
and Current Alarms dialog box is being viewed will be added to the display. If a current
alarm condition is ‘normalised’ ie the problem condition is rectified, the alarm will be
removed from the displayed list.

(ii) Beacon Setup

The Beacon Setup selection from the View menu changes the centre panel of the display
to Beacon and Polariser Control, an example of which is shown in Fig. 9.

This display is specific to the beacon system installed on the connected antenna, and, if
the antenna has no polariser under TS3010 control, the group on the right hand side of the
centre panel is replaced with a message stating that fact.

Changes made on this display immediately affect the settings used by the ATCU and the
beacon receiving equipment. However they do not change the settings stored as default
settings for the currently selected satellite, unless the appropriate ‘Set as Default’ button is
activated. At any time, the current satellite’s default settings may be retrieved from the
ATCU by activating the appropriate ‘Retrieve Defaults’ button.

The Beacon Level Offset is subtracted from the level reported by the beacon receiver, to
obtain a value used by the ATCU for evaluation, and for display by the CMU as the
Beacon Signal Strength.

Beacon High and Low Limits are used by the ATCU to prevent active tracking of a signal
which is either too strong (the antenna might be looking at the sun) or too weak (so that
an attempt is not made to track noise). The Rate Limit prevents spurious data on signal
strength being used, and aids the ATCU to determine if the satellite has suddenly changed
orbit. ( A minor alarm is generated if such is determined, to warn the operator.)

The ATCU must be given an estimate of the antenna’s beamwidth for each Beacon
channel (or frequency) to be used. An accuracy of 30% is adequate here - the information
is used by ORBIT TRACK to estimate satellite movement.

If a Polariser is fitted to the antenna, and is under ATCU control, the right side of the
display will include Polariser controls and information. Fig.9 shows an example of this.
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Fig. 9  Beacon and Polariser Control Display

See the installation’s Manual Supplement for more details about this view.

(iii) Editor

The Editor selection activates SuperEditor, a text editor similar to WordPad, which can be
used for general purpose text file creation, editing and printing. When opened from the
View menu, SuperEditor’s ‘File - Open’ command dialog is positioned in the Alarms
folder for the connected antenna, for convenience. Any alarm file may then be selected,
including the currently open alarm file (which cannot however, be changed).

SuperEditor has a useful addition to the general purpose editor on which it is based. Any
text at the beginning of a file which is delimited  by ‘$’ characters will be used as a page
header during printing - but note that the font within the header is Courier New, size 10,
and cannot be changed.
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Fig. 10  SuperEditor

 (iv) Positioning and Tracking

This View menu selection returns the display to the startup condition shown in Fig. 2,
which provides the means of:-

a. controlling the ATCU Mode and setting mode-specific parameters;
b. giving the ATCU Position or Rate demands;
c. changing offsets, except when in ORBIT TRACK mode, and
d. setting satellite or star parameters.

Mode control is effected by making a selection from a ‘drop-down’ list in the Operating
Mode selection box. Alternatively, for Position and Rate modes, making an entry in one
of the Position or rate demand edit boxes will automatically set the appropriate mode.

On a change of mode, the display’s centre inset (headed ‘OFFSET ADJUSTMENTS’ in
the Fig. 2 example) may change, providing access to parameter settings appropriate to the
new mode. If StarTrack mode is selected, the Satellite selection control on the right
changes to a Star selection control, and a second inset appears under the Star selection
control which provides control of the TUNRA Antenna CAlibration System (ACAS).

Star or satellite selection (as appropriate) is made by extending the drop-down list of the
selector box. Here will be a list of 10 satellites or 5 stars (as appropriate to the set Mode),
by name. The satellite (or star) to be used may be selected by positioning the pointer on
the desired satellite or star, and pressing the LEFT mouse button. Parameters specific to
any one of the listed satellites (or stars) are accessed by extending the list, positioning the
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pointer on the required satellite or star, and clicking the RIGHT mouse button. This will
activate a Satellite or Star Data dialog box as appropriate, through which all the
parameters stored in the ATCU for that satellite or star may be accessed.

Fig. 11  Star Data Dialog Box

Fig. 12  Satellite Data Dialog Box

The Satellite Data box contains a number of ‘Property Sheets’, which may be selected by
clicking on the required tab. Each sheet has a Set button, and changes will not be stored
unless the Set button is activated on the sheet on which the changes were made. Any
changes not set in this way will be lost when another Property Sheet is selected, or the box
is killed (by clicking the Close button, top right-hand corner). The Polariser sheet will not
be present if no polariser is fitted, and the Beacon sheet will reflect the specific
requirements of the beacon receiving system installed on the antenna.

(v) System Status

Selecting System Status from the View menu changes the centre panel of the CMU
display to one providing an instant appreciation of the condition of the antenna and
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TS3010 system. Because of variations between antennae, it is specific to each antenna
installation, an example being depicted in Fig. 13.

Fig. 13  System Status Display

Each system alarm state is represented on this display, and its condition indicated by a green
(inactive) or red (active) square. Alarm suppression is used in generating this display, so that any
alarms dependant upon another are shown greyed (ie unknown) if that controlling alarm is active.

 (vi) Trending

The last selection from the View menu - Trending - fills the display’s centre panel with the
Trending display. This has two modes of operation - Real Time and Historical - switching from
one to the other being carried out by activating the button provided for that purpose at the lower
centre of the display.
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Fig. 14  Trending Display (Real Time)

The centre of the Trending display is occupied by the Trending Chart, which represents a window
on a strip chart, which scrolls to the left when in Real Time. The traces shown on the chart are:-

a. Beacon signal strength (red);
b. Antenna Azimuth pointing angle (white), and
c. Antenna Elevation pointing angle (yellow).

6.3.2.3. The Help Menu

6.3.2.3.1. A normal Windows-style Help system is accessible via the Help menu:-

Fig. 15  The Help Menu

6.3.2.3.2. Subject search or context-sensitive help is selectable via this menu, or by the
normal Windows ‘hot keys’ of F1 and Shift-F1 respectively. The third option from the Help
menu provides information on the Revision of the CMU application which is running.
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6.3.3. Taking Control

6.3.3.1. When the ATCU starts, no CMU is in control, so the button in the CMU’s
Condition Panel will be labelled `Take Control' and will be green. Clicking on this will place the
CMU in control of the ATCU and the ATCU in control of the Drives. The button will then be
labelled `Release Control' and will be red. If two CMUs are connected to the ATCU, the other
CMU cannot take control, and its button will be disabled.

6.3.4. Setting Parameters

6.3.4.1. No system parameters can be altered from a CMU which is not in control. Only
those parameters affecting CMU display functions such as page selection, Trending controls and
serial port selection are operable when not in control.

6.3.4.2. Changeable parameters are altered by the following sequence of actions:

(i) Click the cursor inside the required edit box.

(ii) Enter the desired new value via the keyboard.

(iii) Press the Enter key (or the Set button, in dialog boxes provided with one).

If the entered value is outside pre-defined limits for a particular parameter, the parameter will not
be changed and a small dialog box will request entry of an acceptable value. Further, if a change
is made without completing the process (ie not doing (iii) above), a small dialog box will request
a decision as to whether the change should be kept or discarded, when another control is selected.

6.3.4.3. If a parameter may not be changed because of the current state of the system, the
edit box, although showing the current value, will be disabled, showing a non-white background.

6.3.5. Controlling the Drives and the Antenna

6.3.5.1. The two centre buttons at the bottom of the CMU display (in the Control Panel)
are the controllers of major drive and antenna functions. The left button controls Drive operation.
It is disabled unless the Drives are capable of operation, and the CMU is in control. The button is
labelled either `Stop Drives' or `Start Drives' depending upon whether the Drives are, or are not,
controlling the antenna axis motors. Activating the `Start Drives' button sends a Start Drives
command to the Drive start sequencing system. Activating the `Stop Drives' button results in the
Drives becoming disabled. Once the Drives are operating, the antenna control button becomes
active. This button is labelled either `Hold' or `Go', depending upon whether the ATCU is
generating new position commands or maintaining the current positions as commands (`holding’
the antenna in one position). Only after the Go button has been activated will the antenna move,
when it is under TS3010 control.

6.3.5.2. The button on the far right of the Control Panel provides access to antenna
stowing operations. It is only enabled if the CMU is in control. Activating it displays the Stowing
dialog box, an example of which is shown in Fig. 16. The Stowing button is disabled if the
Drives are not operating.
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6.3.5.3. This dialog box is automatically configured to match the stowing facilities of the
connected antenna. The one shown in Fig. 16 reflects an antenna with a stowing position for each
axis, and an elevation axis stowpin, which is capable of being controlled by the TS3010.

Fig. 16  The Stowing Dialog Box

6.3.5.4. The user may opt for automatic or manual insertion of stowpin(s), by clicking the
small button near the top of the box. If this is set for automatic insertion, the following sequence
will occur if the Stow button is activated:-

a. a Traffic Disruption Warning may appear, requesting confirmation of the action;
b. the antenna will be driven to its Stow position;
c. when both axes have settled in their stow positions, the Drives will shut down, and
d. if an axis with a stowpin is properly aligned to its stow position, that stowpin will
automatically be given an ‘Insert’ command. A Progress display will then appear,
indicating the approximate consumption of allotted time for the insertion operation. When
the pin is fully inserted, the Progress display will disappear, and the Stowpin Control
button will be labelled ‘Extract’.

If automatic insertion is not selected, the automatic operation terminates without inserting the
stowpin(s). Manual activation of the ‘Insert’ stowpin control buttons may then be used.

6.3.6. Positioning the Antenna

6.3.6.1. If it is not visible, select the Position and Tracking panel from the Views menu.

6.3.6.2. If the ATCU is not in Standby or Holding state, activate the Hold button.

6.3.6.3. Set the required antenna azimuth and elevation positions in the edit boxes
provided. This action will automatically set Position mode.

6.3.6.4. If the ATCU is in Standby state, activate the Start Drives button. This will turn
red, turning into a Stop Drives button. After a short delay (dependent upon the particular antenna
installation), the ATCU state will change to HOLDING. During the starting sequence, a Progress
display will then appear to the left of the Drives control button, indicating the approximate
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consumption of allotted time for the starting operation. When the Drives have started, the
Progress display will disappear.

6.3.6.5. Activate the Go button. This will turn red, turning into a Hold button, and the
antenna will slew to the set position. When the antenna reaches this position, the ATCU State
will revert from Slewing to Following. The Offset controls may then be used to `nudge' the
antenna about a position. By setting a non-zero value of increment, and clicking on the button for
the required nudge direction, the relevant position command will be changed by the set increment
size, and the antenna will follow.

6.3.7. Finding a Satellite

6.3.7.1. An approximate knowledge of the pointing angle required for the antenna to see
the satellite is required. The better this is, the less time will be spent in searching. Further, an idea
of the beacon signal level expected from the satellite would be useful.

6.3.7.2. Under position control, move the antenna to the estimated position of the satellite.

6.3.7.3.  Put the antenna on Hold (activate the Hold button), and using the drop-down
combo box provided on the left of the Position and tracking panel, select Scanning Mode. The
display in the centre of the panel will change to a Scanning Setup display, in which all the
parameters controlling the scanning operation are presented for editing. (See Fig. 17.)

Fig. 17  Scanning
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The ‘Box' size defines the size, in elevation and cross-elevation, of the sweep which the antenna
will make. If Spiral Scan is selected, the sweep will be in the form of an expanding spiral,
centred on the starting position and moving outwards, with each pass being further out than the
last by the specified Separation. The rate of movement is constant, at the set Scan Rate. This
motion continues until the diameter of the spiral equals the set box size, the set time expires, or a
beacon signal is found.  If Bar Scan is selected, the antenna moves in horizontal bars, as shown
in Fig. 18, until the box size in elevation coverage is reached, the set time expires,  or a beacon
signal is found.

Fig. 18  The Bar Scan Pattern

Scan-speed sweeps

Fast slews

Starting point

Separation

Box size

6.3.7.4. Set up scan parameters appropriate to the task - if the estimate of satellite position
is known to be within +/- 2 degrees, set a box size of say 4 degrees. A scan rate of 0.03
degrees/second is normally acceptable, and the time limit should be set so that the scanning
system has time to traverse most of the set scanning box. Select Spiral or Bar Scan according to
preference. When satisfied that all the settings are acceptable, activate the Set button. Until the
Set button is activated, the original settings may be restored by activating the Cancel button.

6.3.7.5. Select the Beacon and Polariser display from the Views menu, and set beacon
frequency, beacon level limits to appropriate values for the satellite. Typically, high and low
limits would be set to say +5 and -15 dB respectively. The Fade Rate Limit parameter sets a rate
limit for the generation of a minor warning alarm, and may be reasonably set to 0.3 dB/sec.
Beamwidth should be set to approximate that of the antenna at the set beacon frequency. ( A
tolerance of +/- 30% on this figure is quite acceptable.)

6.3.7.6. Activate the Go button. The antenna will now move in a pattern corresponding to
the settings made, until

a. the ATCU recognises that the beacon receiver is reporting a beacon signal strength
above the set lower limit;
b. the antenna has been driven to the limits of the search box set, or
c. the set time limit has expired.

6.3.7.7. If the search has found the satellite, a dialog box advising of same will appear. If
the search has failed, a dialog box advising of this fact will appear. In either case, the ATCU will
revert to the HELD state, and all antenna motion will cease.
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6.3.8. Tracking a Satellite

6.3.8.1. TS3010 provides three methods of satellite tracking. ORBITTRACK mode provides
‘Active’ tracking, in which a beacon signal from the satellite is followed, and ‘Passive’ tracking
during beacon signal loss, following a model built during active tracking. The Intelsat and Norad
modes allow only for ‘Passive’ tracking, in which the Intelsat or Norad model for the satellite is
followed.

6.3.8.1. Using ORBITTRACK

6.3.8.1.1. Ensure that a suitable step size is set for the selected satellite. (This setting may be
adjusted in the Satellite Setup dialog box, on the OrbitTrack property page - see Fig. 19.) A
reasonable step size is 5-10% of antenna beamwidth at the beacon frequency to be used. The
larger the step size, the more quickly tracking will optimise the antenna position and the less
susceptible tracking will be to external disturbances such as violent wind gusts. However the
negative aspect of setting a large step size is that during the stepping sequences, signal strength
may be adversely affected.

Fig. 19  ORBITTRACK Settings for a Satellite

6.3.8.1.2. With the Positioning and Tracking panel displayed, use the Mode selection box to
set OrbitTrack mode. The centre of the panel will change to provide facilities for setting the
OrbitTrack start type - Cold or Warm. This is shown in Fig. 20.

6.3.8.1.3. If the satellite has not recently been tracked in ORBIT TRACK mode, a ` Cold
Start' to tracking will be necessary. In this type of start to tracking, no ORBIT TRACK model is
used, and the antenna must first be positioned close enough to the satellite direction for the
beacon signal strength to be above the lower limit set on the Beacon Setup page. This may be
done using the procedures described in Finding a Satellite. If a Cold Start is attempted while a
valid ORBIT TRACK model for the selected satellite exists, a warning dialog box will request
confirmation or cancellation of the action, before the start is attempted. If a model exists and the
start is confirmed, the existing model will be lost, and a new one built in its place.
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6.3.8.1.4. The alternative start style for ORBIT TRACK tracking is a `Warm Start'. This is
the default start method, and requires the presence of a valid Orbit Track model from the selected
satellite. Before a Warm Start, the antenna may be positioned anywhere. The first action after the
start is for the ATCU to automatically drive the antenna to point in the direction of the satellite
estimated from the ORBIT TRACK model. If no model exists for the selected satellite, a warning
will be issued, and the start will not be carried out. If a model exists but is estimated by the
ATCU to be unreliable (usually because of its age), a warning dialog box will request
confirmation or cancellation of the action, before the start is attempted.

Fig. 20  ORBITTRACK Display

6.3.8.1.5. After an initial sequence of stepping motions about the satellite direction, the
antenna will settle down to a fairly consistent pattern of Stepping followed by from 1 to perhaps
30 minutes or more of model tracking. The smaller the satellite motion, the longer the model
tracking time will be. (The maximum time that can elapse between stepping patterns may be set,
for each satellite, in the OrbitTrack page of its Satellite Setup dialog box.)

6.3.8.1.6. During the Stepping sequence, the antenna is driven in a pattern of steps away
from the mean pointing direction as follows:-

a. step 1 unit up, pause;
b. step 2 units down, pause;
c. step 1 unit up and step 1 unit clockwise, pause;
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d. step 2 units anti-clockwise, pause;
e. step 1 unit clockwise.

The size of the step unit is the Step Size set in the OrbitTrack property page of the Satellite Setup
dialog box for the satellite selected. Note that the Step Size specifies elevation and cross-
elevation movement, thus at high elevations, relatively large azimuth movements result. The
pause period during the Stepping sequence is approximately 6-7 seconds.

6.3.8.1.7. Within 15 minutes of a Cold Start, the antenna should be tracking the satellite
accurately, with beacon signal strength at maximum average level.

6.3.8.2. Using INTELSAT

6.3.8.2.1. Ensure that current Intelsat parameters are set for the selected satellite. These
parameters may be checked, and set, on the Intelsat property page of the Satellite Setup dialog
box for the selected satellite - see Fig. 21. Here, each of the 11 parameters, and the epoch time
and date for the parameter data, may be entered, or a standard Intel data file set may be read-in
from a floppy disk.

Fig. 21  Intelsat Settings for a Satellite

6.3.8.2.2. When entering new Intelsat parameters, a 170 hour cross-check is available to
verify that the data input is correct, before activating the SET button to send the data to the
ATCU. (Intelsat parameters are always provided with the satellite latitude and longitude at 170
hours after the epoch, as determined using the parameters given. By carrying out the same
calculation, the user can verify that the data has been entered correctly.) If the data is read-in from
a floppy disk, the check is carried out automatically, and the 170 hr. Check displays indicate
‘OK’ or ‘Fail’, depending upon the results.

6.3.8.2.3. Dismiss the Satellite Setup dialog box, select Intelsat Mode, start the Drives and
activate GO. The antenna will slew to the calculated satellite direction, and start following the
Intelsat model.
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6.3.8.2.4. Fine adjustment of the antenna position may be necessary to optimise the received
signal strength. For this purpose, in Intelsat Mode the centre of the Positioning and Tracking
panel retains the Offset controls shown there when in Position Mode. The offsets thus arrived at
are thenceforth held in the ATCU memory store for that satellite, and come into effect whenever
Intelsat tracking is undertaken with the same satellite selected.

6.3.8.2.5. If Intelsat tracking is continued past the ‘Duration’ of the parameters set - Duration
being provided with the parameters - a warning that they are getting out of date will appear.
Should Intelsat tracking be continued for another 48 hours, an alarm will be raised and the ATCU
will revert to the HELD state, stopping tracking operations.

6.3.8.3. Using NORAD

6.3.8.3.1. Ensure that current Norad parameters are set for the selected satellite. These
parameters may be checked, and set, on the Norad property page of the Satellite Setup dialog box
for the selected satellite - see Fig. 22. Here, the Norad data (in the standard Norad two-line
format), may be entered, or a standard Norad data file set may be read-in from a floppy disk.

Fig. 22  Norad Settings for a Satellite

6.3.8.3.2. When entering new Norad parameters, a check-sum test is available to verify that
the data input is correct, before activating the SET button to send the data to the ATCU. (Norad
parameters are always provided with a checksum figure as the last character on each line of data.)
Note that spaces count as individual characters in Norad data. Be especially careful to enter
the number of spaces shown in the Norad data between other characters. If the data is read-
in from a floppy disk, the check is carried out automatically, and the Check-sum test displays
indicate ‘OK’ or ‘Fail’, depending upon the results.

6.3.8.3.3. Dismiss the Satellite Setup dialog box, select Norad Mode, start the Drives and
activate GO. The antenna will slew to the calculated satellite direction, and start following the
Norad model.
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6.3.8.3.4. Fine adjustment of the antenna position may be necessary to optimise the received
signal strength. For this purpose, in Norad Mode the centre of the Positioning and Tracking panel
retains the Offset controls shown there when in Position Mode. The offsets thus arrived at are
thenceforth held in the ATCU memory store for that satellite, and come into effect whenever
Norad tracking is undertaken with the same satellite selected.

6.3.8.3.5. If Norad tracking is continued past the ‘Duration’ of the parameters set - Duration
being provided with the parameters - a warning that they are getting out of date will appear.
Should Norad tracking be continued for another 48 hours, an alarm will be raised and the ATCU
will revert to the HELD state, stopping tracking operations.

6.3.9. Controlling the Beacon Receiving System

6.3.9.1. TS3010 provides for a set of Beacon system parameters to be stored for each of
the ten satellites allowed for. The maximum capacity provided is for two ‘sets’ of receiving
equipment (or two configurations of some or all of the equipment) with up to five frequency
‘channels’ for each. The Beacon and Polariser display, available through the Views menu, and the
Beacon property page in the satellite setup dialog box, are configured to match the beacon system
installed on the connected antenna. (Note that if two ‘sets’ are in use, only one is used to provide
tracking information for the ATCU. In this case, the set being used may be changed at any time.)

6.3.9.2. The ATCU and CMU maintain the currently used Beacon system parameters
separately from the ‘default’ settings stored for each satellite. The parameters displayed in the
Beacon and Polariser view are the parameters currently in use, and these can be changed at any
time. The current parameters may be restored  to the default parameters for the current satellite,
by operating the Restore Defaults button below the displayed settings, and the current settings
may be set as the defaults for the currently set satellite, by operating the Set As Defaults button.

6.3.9.3. For details relating to Beacon system settings and displays, refer to the TS3010
Manual Supplement for the antenna installation.

6.3.10.  Polariser Adjustments

6.3.10.1. The TS3010 CMU in control provides facilities for setting a polariser, should one
be fitted to the connected antenna. Facilities for setting a default setting for each satellite, and
adjusting the current setting - similar to those provided for the Beacon setup - are provided.

6.3.10.2. A Polariser may be controlled whether or not the antenna drive system is
operating.

6.3.10.3. For details relating to Polariser settings and displays, refer to the TS3010 Manual
Supplement for the antenna installation.

6.3.11. Using the Trending Facilities

6.3.11.1. The Trending display available via the Views menu on the CMU provides
facilities for reviewing antenna movement and beacon signal strength. A display similar to a chart
recorder is presented in the centre of the screen. Vertical scale and offset adjustments may be
made at any time, by changing the values displayed to the left of the screen. Whenever one of
these settings is changed, the display is re-drawn according to the new setting.
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6.3.11.2. A display-mode selection button near the bottom of the panel may be used to
toggle the Trending display between Real Time and Historical mode. In Real Time, the chart
scrolls to the left, the traces being ‘drawn’ as if by pens positioned on the right-hand edge of the
chart window. The horizontal scale in this mode is fixed at 5 minutes for the width of the chart
window. In Historical mode, the chart is static, displaying data previously recorded.  Fig. 14
shows the Trending display in Real Time mode. Historical mode is depicted in Fig. 23:-

Fig. 23  Historical Trending Display

6.3.11.3. Toggling the display into Historical mode brings a range of facilities into being:-
a. The horizontal scale may be adjusted to cover up to 7 days, using the drop-down combo
box near the bottom of the chart, in the centre.

b. The chart may be panned to left or right, by half the window time-span, or by 24 hours.
Four buttons are provided for this purpose. Up to 30 days of past recording may be
viewed in this way.

c. A cursor - seen as a green vertical line in the chart window, may be used to determine
precise values of the three traces at the time represented by the position of the cursor.
Initially, the cursor is at the right-hand edge of the chart window. It may be moved across
the window by dragging the cursor control slider (below the chart) with the mouse. The
readings are displayed on the right-hand side of the screen, along with the date and time
represented by the cursor’s position.
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d. Some or all of the data displayed on the historical trending chart may be printed out, if
a suitable printer is attached to the printer port of the CMU. A selection of readings may
be made by spanning the required section of the chart by two clicks of the pointer with the
left mouse button. Each click will produce a white vertical line to show where it was
made. Once two such lines are generated, the Review Selection button is enabled. If this is
activated, an instance of SuperEditor is created, loaded with a text file containing the
Trending samples selected. The file is automatically provided with a heading, and may be
edited, printed or copied as required through the normal facilities of a Windows text
editor, all provided within SuperEditor. Note that to avoid heading/text misalignment,
font styles and sizes should not be changed, as the heading is printed only in the font
shown when the editor is invoked - Courier New, size 10.

Each line displayed represents one sample of recorded data displayed on the chart, so the
printout can be up to 300 lines (the number of samples displayed on the chart).

The time between output lines is governed by the chart width setting. Thus if this is 5
minutes, one data line for every second will be printed. If the width is 10 minutes, one
data line for every two seconds will be printed, and so on.

The output data is not effected by the scaling or offsets used to control the chart display.

e. If the ATCU not in a state in which it is moving or holding the antenna position, and it
is in Position Mode, a  ‘Set Position Commands' button will be enabled on the right side
of the screen. Clicking on this button will set the current cursor readings of azimuth and
elevation angles as the current Direct Control position commands, ready for a Position
mode drive to that position.
Scales and offsets for the display may be changed by use of the controls on the left. Note
that these affect the displayed traces only - the data on which the chart is based is stored
as original measurements.

6.3.12. External Computer Control

6.3.12.1. The TS3010 ATCU has the capability of using externally generated position data
to position the antenna. This is done via its Control Port, and a special ATCU  EXTERNAL
Mode, selectable via the Mode Selection facilities in the Positioning and Tracking view, is
provided for this type of operation.

6.3.12.2. The Control Port is a standard RS-422 serial communications port. Its setup
details and the required message format are provided in Specification. This port is a Receive
Only port. That is, it will act on data received in the correct format, but does not produce any
response to the sender. The message required must contain both azimuth and elevation position
data, representing the pointing angle to which the antenna is required to move.
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6.3.12.2. To place the antenna under the control of data received at the Control Port, use the
Mode selection facilities in the Positioning and Tracking panel to set External Mode.

WARNING: Whenever the Drives are in their operating state the antenna will
follow the external position commands. No ‘Go’ button activation is required.

Start the Drives (click on the Start Drives button). The antenna will remain stationary until a valid
position command is received at the ATCU’s Control Port. The antenna will then be driven to the
position given.

6.3.12.3. The External Mode may be left at any time, by selecting another mode.

6.4. Antenna Motion Limits

6.4.1. The TS3010 ATCU monitors the condition of each antenna motion limit switch - UP,
DOWN, CW, CCW, pre- and final limits. If the antenna moves to a point where one of the pre-
limit switches opens, the ATCU will disable both Drives and revert to the OFF state. The antenna
cannot then be moved under TS3010 control, and must be moved away from the limiting position
under manual control. Whenever a pre-, final or software limit is reached, an alarm is generated
at each connected CMU.

6.4.2. A set of software motion limit positions is set into the ATCU during installation and
setting-to-work. These are set just within the antenna motion pre-limit switch positions. The
ATCU will not drive the antenna past these preset positions, but will not disable the Drive on the
offending axis. Instead, it will hold the antenna at that position until the demanded position falls
within the software limit, when it will again drive the antenna to follow the demand.

6.4.3. Another set of software limits is available, which may be set by the operator. These are
specific to the selected satellite, and are known as ‘Tracking Limits’. They may be set in the
satellite’s Setup dialog box (see Fig. 12). The settings made will be effective ONLY when that
satellite is selected for tracking, and tracking is in operation. The limits for azimuth may be set as
+ve or -ve angles - the ATCU works out the correct application (which may be dependent upon
the antenna’s cable wrap condition). Thus, for example, if a satellite is positioned at 0 degrees,
limits may be set as cw = +10.0 or -350.0, ccw = -10.0 or +350.0.

6.4.4. If the satellite-specific software limits are set such that the applied clockwise limit would
be less than +0.1 degrees greater than the applied anticlockwise limit,  they will be disregarded
and the preset software motion limits for the azimuth axis will be applied. Similarly, if the up
limit is set less than +0.1 degrees greater than the down limit, these limits will be disregarded and
the preset software motion limits for the elevation axis will be applied. Further, if a Tracking
Limit setting lies outside a preset motion software limit, the latter will be applied.

6.4.5. If a position command is issued which is beyond a preset software limit, an alarm is
generated, but the antenna will move towards the required position, stopping only when the preset
software limit position is reached.

6.4.6. If the antenna reaches a software limit, the ATCU holds it at that position and an alarm is
generated. Movement about the other axis may continue. If the position command for the
offending axis then moves inside the software limit, the antenna will follow.
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6.4.7. The software limits in effect at any given time are displayed in the lower right corner of
the Positioning and Tracking panel.

6.5. Alarms and System Status

6.5.1. Alarms and Events

6.5.1.1. TS3010 treats ‘Alarms’ and ‘Events’ as similar entities.  Whereas ‘Alarms’ are
‘Events’ which may have an impact on operations, and are generally the result of undesirable
occurrences, ‘Events’ may be alarms, or just items of interest - for instance, changes of mode or
state. In further discussion, both alarms and events will be considered under the umbrella of the
term ‘events’, but alarms may also be referred to as ‘alarms’.

6.5.1.2.  Events are classified as Major, Minor, Info and FileOnly. These are defined as:-

a. Major: A problem detrimental to antenna performance.

b. Minor: A warning that something might not be 100%, but is not likely to cause a
reduction in antenna performance.

c. Info: An occurrence of interest to the operator, but not generally of an
undesirable nature.

d. FileOnly: An occurrence which may be of interest to maintainers of hardware and
software, but are of no consequence during general use.

6.5.1.3. A Major alarm causes an major alarm dialog box (background colour is red) to
appear on the screen of the CMU in control. That CMU generates an audible alarm until the
major alarm dialog box is acknowledged. The ATCU is forced to the OFF state, stopping all
antenna motion. Even after the cause of a Major alarm is removed, the alarm message remains
present, and the sound continues, until the alarm is acknowledged by the operator (by dismissing
the dialog box). Currently active major alarms will appear in the Events list if this is displayed,
and are recorded on the Events log. file.

6.5.1.4. A Minor alarm causes an minor alarm dialog box (background colour is orange) to
appear on the screen of the CMU in control. That CMU generates an audible alarm until the
major alarm dialog box is acknowledged. The sound produced is different from that generated
when a major alarm occurs. The operation of the ATCU is not interrupted. Even after the cause of
a Minor alarm is removed, the alarm message remains present, and the sound continues, until the
alarm is acknowledged by the operator (by dismissing the dialog box). Currently active minor
alarms will appear in the Events list if this is displayed, and are recorded on the Events log. file.

6.5.1.5. Info alarms or events are listed in the Events list if it is displayed, and are recorded
in the Events log. file. They do not generate any warning messages or sound.

6.5.1.6. FileOnly alarms or events are recorded in the Events log. file, but are never listed
in the Events display, they do not generate any warning messages or sound.

6.5.2. Event Files
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6.5.2.1. All events are logged to an event file. The file contains the date and time of the
event, an event reference number and a brief explanatory message. The normalisation of any
major or minor event is also logged, with date and time, and the reference number of the event
normalised.

6.5.2.2. Event files are maintained in a directory - ‘Event Files’ - on each CMU's hard
disk. This directory is a sub-directory of a directory named for the connected antenna. The file
names indicate the date of their creation, and the extension the serial number. The first file
generated after midnight (CMU-time) is serial numbered 000. Each file thereafter on that date is
given an extension incremented from the previous file’s extension.

6.5.2.3. The currently open Event file is closed when it reaches a predetermined length
(200 entries), at midnight (TS3010 system time) or when the CMU program is terminated.

6.5.2.4. Event files may be viewed, edited, copied to disk or printed out (if a printer is
attached to the CMU) by use of SuperEditor, accessed through the Views menu Editor item.

6.5.2.5. A list of all possible alarms is provided in the TS3010 Manual Supplement for the
installation.

6.5.3. The System Status Display

6.5.3.1. The overall status of the antenna, its Drive system and the TS3010 may be viewed
at a glance by selecting System Status from the Views menu. Here, a green or red indicator shows
the condition of various major functions. If the condition of a function cannot be determined due
to another failure being present, its indicator will be blank.

6.5.3.2. The Status display is specific to each antenna installation. An example display is
shown in Fig. 13. The display for a particular installation will vary from this in detail, but the
general arrangement will be similar.
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7.         ANTENNA CALIBRATION FACILITIES

7.1. Antenna Calibration Methods

7.1.1. Insofar as tracking and antenna control is concerned, the subject of antenna calibration is
limited to pointing angle optimisation, receiver gain vs equivalent temperature (G/T) and beam
shape. TS3010 includes facilities designed to assist with meeting these calibration requirements.

7.1.2. If an antenna is to be used for communications with satellites within a small pointing
angle window,  simple offset adjustments to maximise the signal from a satellite near the middle
of the window may be sufficient. For wider viewing however a model of optimum offsets over
the viewing window may be required. (But note that by using ORBIT TRACK, no calibration or
adjustment is required.)

7.1.3. Radio-source stars are a convenient reference for antenna calibration procedures, as they
are point sources at very accurately known positions. TS3010 includes Star Track, a model-
tracking program which will follow the trajectory of a given star with extreme accuracy (typically
better than 0.002 degrees), and can thus be used to determine pointing corrections near the paths
of available radio-source stars.

7.2. Star Tracking

7.2.1. From the Mode selection facility in the Positioning and Tracking display, the Star Track
Mode may be set. When this is done, the Satellite Selection box turns into a Star Selection box,
and the Antenna Calibration System facility is presented as a small window below it.

7.2.2. Each of five stars may be selected by a left mouse button click on the required star, and a
Star Setup dialog box opened by a right click (similar to the actions for satellites).

7.2.3.  The Star Setup dialog box provides facilities for setting epoch values (in declination and
right ascension degrees) together with Epoch year, for up to five stars, as well as setting an
arbitrary name for each.

7.2.4. Activating the GO button (after starting the Drives) with the Star Track mode set will
cause the antenna position demands to be made equal to the pointing angle required for the star to
be aligned with the antenna main beam axis, if that axis is exactly correct. Offset adjustments
may then be made to maximise the detected signal from the star. If this is done for a number of
stars within the required coverage of the antenna, the offset data thus collected may be used, in
conjunction with the star position at the time the offset data was determined, to develop a model
of the needed offsets at any point in the region covered.
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7.3. TS3010 Calibration Model and Constants

7.3.1. The TS3010 ATCU contains a calibration correction model which will accept up to 8
parameters covering both azimuth and elevation offset corrections. These constants are available
for review and setting only via the ATCU, when it is fitted with a VDU and keyboard (see ATCU
MAINTENANCE FACILITIES). The model uses the following equations:-

Az correction = P1 + P3/cos(el) + P4 * tan(el) + P5 * tan(el) * cos(az) + P6 * tan(el) * sin(az)

El correction = P2 - P5 * sin(az) + P6 * cos(az) + P7 * cos(el) + P8/tan(el)

7.4. The TS3010 Antenna Calibration System

7.4.1. In StarTrack mode, a small window is displayed below the Star Selection combo box in
the Positioning and Tracking panel. Referred to as ACAS (Antenna CAlibration System) , this
window contains variables and switches to control an in-built driver which nods the antenna
about the tracking angle, in a cyclic fashion. Used in conjunction with the ATCU's Dataport,
calibration information may be collected automatically over an extended period.

7.4.2. The ACAS nodding pattern is shown in Fig. 24.

Fig. 24  Antenna Calibration System Nodding Pattern

The values of Pointing Offset, Pointing Period, G/T Offset and G/T Period may be set, as well as
the number of times each pattern is repeated within each overall cycle. In the ACAS control inset,
Cycle A refers to the Pointing Pattern and Cycle B refers to the G/T Pattern.

7.4.3. Note that offsets about the vertical are in CROSS-ELEVATION. Thus if the antenna is
pointing at a high elevation, a small offset will have a large effect on azimuth angle:-

azimuth offset = cross-elevation offset / cos(elevation angle)

7.4.4. The ACAS nodding pattern is initiated by activating the ACAS Start button, which will
then turn into a Stop button. The ACAS Pause button will freeze the nodding at the current
condition, and the button will turn into a Resume button. If this is activated, the pattern will
recommence at the point where it was interrupted by activating the Pause button. The ACAS Stop
button simply causes the nodding to stop, and all current offsets to be removed.
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Cross-elevation
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Total pattern repeated until stoppedStart



TS3010 Satellite Tracking System MANUAL
_____________________________________________________________________________

Page 49 of 60

©TUNRA Ltd 1998                                       DOC- 000 017 7                                        $Revision::   1.11  $

7.4.4. The ATCU Dataport output is an ASCII string. It contains the following information:-

century-year month day hour minute second hundredths-of-second az-position el-position
beacon-strength ATCU-mode ATCU-state elevation-offset cross-elevation-offset az-error
el-error

This data is formatted according to the C-code format specification:-

    %d  %d  %d  %d  %d  %d  %d  %5.3f  %5.3f  %5.3f  %d  %d  %5.3f  %5.3f  %5.3f  %5.3f

There is no stop or start character, and no checksum. The transmission is repeated once per
second. Angle data is in degrees, mode and state data are represented by integer numbers.

7.4.5. The Dataport must be turned on by accessing the Tuning page of the ATCU. To d o this,
attach a keyboard and VGA display to the ATCU. Turn the ATCU ON, then select the Tuning
page. The required setting of Dataport output is Normal, with the Dataport switched to ON.

7.4.6. The Dataport connection is physically the same connector on the ATCU used for either
the LCMU, RCMU or External Control connection. When it is enabled (switched ON from the
ATCU Tuning page) the normal connection for the port used is not available. If the port used is
not that for the RCMU connection, the Manual Supplement for the installation will indicate
which port is used.
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8.         INSTALLATION AND SETTING-TO-WORK

8.1. Software Installation

8.1.1. All TS3010 units are supplied loaded with their required software. Should a re-load of
software become necessary, the following procedures should be followed.

8.1.1. CMU Software

8.1.1.1. If a re-load of Windows NT is required, consult the Windows NT documentation.
Note that Windows NT 4.0 or higher is required. The procedure is straightforward, and no
deviation from the default settings offered are necessary. The installer may vary any of the normal
Windows NT Control Panel settings, excepting that the Display Settings must be either:-

800 x 600 resolution, with Small Fonts, or

1024 x 768 resolution, with Large Fonts.

The latter setting is recommended, provided the CMU computer has that capability. The Colours
setting should be at least 256, and the highest colour setting of which the computer is capable is
recommended. The Refresh Frequency should be as high as possible, but 60 Hz is adequate.

8.1.1.2. Restart Windows, and install the sound card software supplied with the sound
card in the computer, when Windows detects the sound card. (Consult Windows and sound card
documentation for details.)

8.1.1.3. Set Windows’ Recycle Bin size to 10% of the disk size.

8.1.1.4. Using Windows’ Control Panel Services, set Plug and Play startup to Disabled.

8.1.1.5. Edit the file BOOT.INI (which will be found in the computer’s hard drive root
directory) to add ‘/NoSerialMouse’ to the first line in the Operating System group.

8.1.1.6. Two background colours in the CMU application are tied to Windows NT system
colours, and may be changed via the Display Appearance settings. These colours are:-

Condition and Control Panels: Tied to Desktop colour, and

All View Panels: Tied to Inactive Window Border colour.

The user is free to vary the colour scheme to suit ambient conditions and personal preference.

8.1.1.7. If Windows NT 4.0 is used, Service Pack 3 should be applied.

8.1.1.8. Check the installation Manual Supplement for any special changes to COM port
settings that may be required.

8.1.1.9. To re-load the CMU application:-

a. Use the Windows NT ‘Add/Remove Programs’ facility in Control Panel, to remove an
existing CMU installation.

b. Insert the CMU Setup Disk 1 into the computer’s floppy disk drive.
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c. From the Windows Task Bar, click ‘Start’ then ‘Run’. Insert the program name
‘a:\setup’ and press the Enter key. A standard Windows installation will follow. Accept
any default settings offered during the installation.

8.1.2. ATCU Software

8.1.2.1. Ensure that the ATCU is turned OFF, and attach a keyboard and VGA display
monitor to it. (Standard connection points will be found on the rear of the ATCU).

8.1.2.2. Insert the ATCU Master Floppy Disk for the installation in the floppy disk drive in
the front of the ATCU.

8.1.2.3. Turn the ATCU ON. During the boot-up sequence, a message stating that by
hitting the Esc key, the solid-state disk may be changed from Drive A: to Drive B. Hit the Esc
key as soon as this message is displayed. (you only have 1-2 seconds to do this.). The ATCU will
then boot from the Master Floppy Disk rather than from the installed solid-state disk. The Master
Floppy Disk will then format the solid-state disk, and copy the appropriate files to the solid-state
disk. When that process is complete, turn OFF the ATCU.

8.1.2.4. Remove the Master Floppy Disk from the floppy disk drive and disconnect the
keyboard and display monitor from the ATCU.

8.2. Antenna Interface Checkout and Connection

8.2.1. All connections to the TS3010 ATCU are made via the Terminal Panel provided, except
for serial communications connections, which are made direct to the ATCU.

8.2.2. The standard procedure for connection of TS3010 to the antenna system (including the
Drives) is to carry out multimeter testing of each circuit before connecting the ATCU cables.
These tests should verify that the connection is correct and the circuit is performing its prescribed
function. Finally, the ATCU cables should be connected, the TS3010 energised and a check made
that each external function registers correctly in TS3010.

8.3. Tuning

NOTE: TUNING THE CONTROLLER IS A HIGHLY SPECIALISED TASK, AND
SHOULD ONLY BE UNDERTAKEN BY TUNRA PERSONNEL.

8.3.1. The only tuning of TS3010 that is required is in connection with the Drive system
controller in the ATCU. The controller is a sophisticated PID controller which combines with the
Drive system to cause the precise antenna motions required during tracking operations.

8.3.2. The TS3010 ATCU provides facilities for adjusting the parameters of its controller, and
for performing the motions and generating the outputs necessary to perform the tuning task. Once
set, these parameters should never need alteration, for the life of the antenna.
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9.         MAINTENANCE

9.1. Computer Hard Disks

9.1.1. The CMU contains a hard disk. Alarm log. and Trending files are stored on this. Both
these file systems are operated on a FIFO system, limiting the disk space consumed to well below
the size of the disk, but providing ample storage for 30 days of records. Provided that the
Windows Recycle Bin size is set to no more than 50% of the disk space, there should be no
possibility of the disk becoming full. Therefore, no disk maintenance will be necessary.

9.2. Fuses and Batteries

9.2.1. Each item of powered equipment in TS3010 is equipped with its own power fuse. These
are readily accessible without access to the inside of units. Always replace with a fuse of the same
type and rating.

9.2.2. The ATCU and each CMU are fitted with a combined clock and battery. The battery life
is estimated at 10 years. To replace this, consult the appropriate Hardware manual supplied with
the system. Before replacing a battery, enter the computer's CMOS SETUP program and make a
note of all settings. After battery replacement, run CMOS SETUP again and verify that all
settings are as before.

9.2.3. The solid-state disk emulator in the ATCU is fitted with a battery to maintain its non-
volatile memory, which is used to store the ATCU program and data files. This battery should be
replaced every 3  years. Before attempting this replacement consult the Hardware manual for the
board, supplied with the system. To prevent loss of  data when changing the battery, a disk copy
of the solid-state disk should be made. To do this, proceed as follows:-

a. Switch off the ATCU, and connect a display and keyboard to it.

b. Turn on the ATCU and the connected display. The ATCU program will start.

c. Close down the ATCU program, by using the key combination Ctrl-Alt-Del.

d. Make a copy of the solid-state disk on a blank floppy disk inserted into the ATCU computer’s
floppy disk drive. Use the DOS utility ‘Diskcopy’ to do this. Remove the floppy disk from the
drive.

e. Turn the ATCU off, and change the battery.

f. Turn the ATCU on. If the ATCU program starts, close it down and  carry out a disk comparison
of the solid-state disk and the floppy disk, using the DOS utility ‘Diskcomp’. If the ATCU
program does not start, or Diskcomp indicates that the two disks are not identical, use Diskcopy
to copy the floppy disk to the solid-state disk.
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9.3. Physical Housekeeping

9.3.1. The only physical maintenance required for TS3010 is to occasionally clean the air
filter(s) on the ATCU. Consult the ATCU chassis manufacturer’s manual (supplied at initial
installation) for details as to how to do this. A wash in warm water and detergent, followed by
rinsing in clean water and drying at ambient temperature is all that is needed. The frequency with
which this should be done is dependent upon the general air cleanliness where the computers are
located.
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10.       ATCU DIAGNOSTIC FACILITIES

**** WARNING ****

Direct access to the ATCU program allows a large number of mission-critical, pre-set
parameters to be changed. Values set in at initial installation are listed in the TS3010

Manual Supplement for the installation.

DO NOT CHANGE ANY SETTINGS UNLESS REPAIR OR PHYSICAL CHANGES TO
THE ANTENNA OR DRIVE SYSTEM MAKE THIS NECESSARY. ANY SUCH

CHANGES SHOULD BE FORMALLY RECORDED, AND THE REASON FOR THE
CHANGE STATED IN THE RECORD.

*****************

10.1. Access

10.1.1. Direct manipulation of the ATCU for normal use is NOT RECOMMENDED. The
ATCU is not provided with a keyboard or display because for normal use, all ATCU functions
should be controlled from a CMU. A keyboard and VGA display can however, be connected to
the ATCU for the purposes of fault diagnosis and system testing or setup during initial
installation. The ATCU is fitted with a VGA display adaptor, and has a standard PC keyboard
connector.

10.1.2. For access to ATCU maintenance facilities, connect a VGA display and PC keyboard to
the ATCU, then turn on the ATCU. The normal ATCU program will then start up. Most ATCU
operations can then be carried out by use of the connected keyboard.

10.1.3. The ATCU Dataport operates out of one of the ATCU serial communications ports.
Consult the Manual Supplement for the installation, to determine which one. A computer running
a serial data-handling program such as Kermit, or MS Windows HyperTerminal, may be used as
a data collector. The port setup required is:-

Data Rate: 9600 Baud
Data Bits: 8
Stop Bits: 1
Parity: None
Flow Control: None

10.2. Displays

10.2.1. The ATCU display system is divided into a number of special-purpose pages. Across the
top of each is a brown bar displaying the three page-access keyboard operations:-

Show Page Menu: Alt-M. This function pulls down a menu of available pages with a
highlight bar indicating the selection. This may be moved up and
down the list of pages with the cursor up/down keys. Pressing the
Enter key brings forward the selected page and removes the menu.
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When the menu is showing, Esc gets rid of it without changing the
displayed page.

Go Back: Alt-B. Pressing the Alt-B key combination takes the display back to
the previously displayed page.

Quit: Ctrl-Alt-Del. This key combination terminates the ATCU program.
It does not reset the computer unless pressed again after program
termination.

10.2.2. Changes to parameters displayed on ATCU pages are made by selection and
editing. Selection is done by moving a cursor - the selected parameter is shown in reverse video
colours. There is one cursor on a page, this being moved around inside a window by use of the
cursor arrow keys, and jumped from one window to the next by pressing the Tab key.

10.2.3. Pages in the ATCU display system are:-

ATCU Functions. This page displays major functions such as antenna position and
movement details, ATCU Mode and State etc.

Beacon System. A display of various Beacon parameters, and a scrolling display of
Beacon Set communications. The latter can be frozen and unfrozen by use of
the ‘h’ key.

Calibration. A variety of parameters to do with Drive system, position
monitoring and pointing calibration are available here for change. These vary
according to the particular installation, but two small windows of data are
always present. These are:-

a. SW Motion Limits. These software limits restrict the positions to which the
ATCU will drive the antenna, and should ALWAYS be set at least 1 degree
inside the pre-limit switch positions. (They are not operative when a STOW
command is made, allowing the antenna to move to its correct stow position if
this is outside the set software limits), and

b. Pointing Coefficients. Eight coefficients of the pointing correction model
built into the ATCU program may be set. These must be derived from
experimental determination of pointing errors within the operating range of
antenna positions, and a knowledge of the model formula. (See ANTENNA
CALIBRATION FACILITIES - TS3010 Calibration Model and Constants.)

CMU Communications. A scrolling display of CMU communications is provided.
One CMU channel at a time is displayed - change to the other by pressing ‘c’.
The display may be frozen and unfrozen by pressing ‘h’. A summation of serial
channel communication hardware errors is also shown - these may be zeroed by
pressing ‘r’. The summation is continuous, and is not dependent upon which
page is displayed.
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Diagnostics. Bringing up this page is harmless UNLESS, having done so, the
question displayed - ‘Set Diagnostics Mode?’ is responded to by pressing ‘y’.
That action will place the ATCU in Diagnostics Mode, and connect the
keyboard actions directly to ATCU outputs.

WARNING - NO SAFETY OR SYSTEM INTERLOCKS WITHIN THE
TS3010 WILL BE EFFECTIVE WHEN IN DIAGNOSTICS MODE.

Without setting Diagnostics Mode, the state of up to 72 digital inputs to, and up
to 72 digital outputs from, the ATCU may be viewed on this page. If
Diagnostics Mode is set, the outputs may be toggled on and off by selection and
toggling with the space bar. Inputs and outputs not available in the particular
ATCU configuration are marked ‘NA’. The two Drive rate control outputs may
also be set, as a plus or minus percentage of their maximum value. Output 1 is
normally connected to the azimuth drive system, Output 2 to the elevation drive
system.

Identification. This is the page provides details of the ATCU program version, and
a set of basic controls for moving the antenna, setting mode etc.

Intelsat and Station. On this page, stored Intelsat parameters may be reviewed and set,
as well as station data (latitude, longitude, azimuth and elevation stow
positions) and the current scan setup.

Norad Data. The stored raw Norad 2-line data for a selected satellite is
displayed, as well as the parameter values decoded from that data. The raw data
may be edited here.

Orbit Track. This page displays Orbit Track conditions and model parameters.

Satellites and Stars. Provides access to some satellite and star settings.

Tuning. Two windows on this page provide access to parameters and functions for
tuning the ATCU Position Control Loops, and for controlling the output from
the ATCU Dataport.
WARNING - POSITION CONTROL LOOP PARAMETERS SHOULD
NEVER BE CHANGED AFTER EXPERIMENTAL OPTIMISATION
DURING INSTALLATION.
See INSTALLATION AND SETTING-TO-WORK - Tuning.

10.3. Use of ATCU Maintenance Facilities

10.3.1. Most problems experienced with TS3010 system installations are found to result from
wiring and/or equipment failures within the antenna itself. The ATCU maintenance facilities are
designed to assist in general electrical system fault-finding, thus no specific instruction on
method of use can be given here. The general notes given below are intended only as a guide, and
should not be considered to place limits on the use of the facilities.
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10.3.1. Communications Problems

10.3.1.1. The Communications Page display may be useful in solving problems encountered with
CMU data exchanges, and the Beacon Page for Beacon Receiving system traffic. Both pages
display transmitted and received data in ASCII format.

10.3.2. Digital and Analog I/O

10.3.2.1. Use of a multimeter in conjunction with the Diagnostics Page and, if necessary,
Diagnostics Mode is advantageous in fault-finding these circuits.

10.3.3. Initial System Setup

10.3.3.1. The Calibration page is used during initial system setup, to match the ATCU to the
installed Drive system and Position Monitoring systems. See the installation Manual Supplement
for details.

10.3.3.2. The Tuning page provides test and tune facilities related to:-

a. Azimuth and Elevation Position Loop Tuning. A window on this page provides access
to all the parameters stored in the ATCU, which relate to the tuning of the Position Loop
for each axis. NEVER CHANGE THESE SETTINGS UNLESS A FULL TUNING
OPERATION IS BEING CARRIED OUT. The settings made in the Tuning Test Controls
window control a rectangular-wave voltage output from the ATCU on each of the
Azimuth and Elevation Rate Control lines to the Drives, and special Dataport outputs for
Azimuth and Elevation resonance and response tests. This enables the operator to drive
the antenna in a fashion useful for measuring resonances and responses by analysis of the
appropriate Dataport outputs.

b. Antenna Pointing Calibration. In this exercise, the Tuning page is used only to control
the Dataport output. This should be set to Normal and turned ON, for this operation.
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11.       REPAIR

11.1. Repair Policy

11.1.1. Repair of TS3010 equipment should be restricted to installation fault-finding and
correction, and Line Item Replacement. Items held as spares should be returned to the supplier for
repair or replacement.

11.2. Precautions

11.2.1. TS3010 equipment contains lethal electrical potentials.

NEVER ATTEMPT REPAIR WHILE EQUIPMENT IS CONNECTED TO POWER.

11.2.2. Components within TS3010 units may be sensitive to static electricity. When handling
computer parts or printed circuit boards from the Terminal Panel or Polariser Control Unit,
always apply anti-static precautions.

11.3. Access for Repair

11.3.1. Terminal Panel

11.3.1.1. The Terminal Panel is directly accessible after removal of the covering panel of
the TS3010 rack.

11.3.2. ATCU Computer

11.3.2.1. Removal of four retaining bolts on the front panel allows the computer to be
moved outwards to the extent of its supporting telescopic rails. In order to access the inside of the
computer, it must be pulled out to the fullest extent of these rails. To do this, pull out as far as
possible. It may then be necessary to depress a button in each rail and pull out further. The top
cover of the computer may then be removed.

**** WARNING ****

ENSURE THAT ALL CABLING IS DISCONNECTED FROM THE COMPUTER, AND
THAT ADEQUATE SUPPORT FOR THE COMPUTER IS IN PLACE BEFORE

CARRYING OUT THE FOLLOWING PROCEDURE

11.3.2.2. The computer may be removed entirely from its rack by fully extending its rails as
described in the preceding paragraph, then levering a sprung retainer in each slide outwards,
allowing the slides to come completely out. (As these retainers are positioned inside the rack, it
may be necessary to remove the side rack covers to carry out this operation.)

11.3.2.3. Note that is it not normally necessary to remove the computer from its rack to
service it.
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11.3.2.4. Computer boards are positively restrained by a bar across the top of them. This
must be removed before a board can be changed. Disconnect any cable from the board (external
or internal) and remove the single retaining screw holding the top rear of the board in place.
Carefully work the board out of its connector. Note that this is often very difficult, due to the
pressure and number of contacts on the boards’ edge connectors. DO NOT TWIST THE
BOARD, AS THIS ACTION CAN CAUSE DAMAGE TO THE BOARD.

11.3.2.5. Before replacing a board in a computer, verify that ALL its links, switches and
other physical settings are according to the listing in the TS3010 Manual Supplement for the
supplied system.

11.3.3. CMU Computer

11.3.3.1. The maintainer is referred to the documentation supplied with the computer.

11.3.4. Re-Assembly

11.3.4.1. On completion of any repair, return the equipment to its original condition. To do
this, perform the steps necessary to gain access in the reverse order, ensuring at each stage that
bolts, screws etc. are made secure.


